# TABLE OF CONTENTS

1. GENERAL DEVICE DESCRIPTION ........................................................................ 7
2. DEVICE CLASSIFICATION ................................................................................ 7
3. INDICATIONS FOR USE .................................................................................. 7
4. WARNINGS AND CAUTIONS ............................................................................ 8
   4.1 Meaning of Signal Words ........................................................................ 8
   4.2 Description of Symbols .......................................................................... 8
   4.4 General Cautions and Warnings .............................................................. 9
5. PRESCRIPTION DEVICE STATEMENT ............................................................ 10
6. OPERATOR QUALIFICATIONS ......................................................................... 10
7. USE OF ULTRASOUND IN OPTHALMIC DEVICES ........................................... 11
8. ULTRASONIC EXPOSURE AND INTENSITIES ................................................. 11
   8.1 Tissue Exposure to Ultrasound Energy .................................................. 11
   8.2 Ultrasonic Intensities .......................................................................... 11
9. BIOMETRIC IMAGING CAPABILITIES ............................................................ 11
10. SOFTWARE INSTALLATION INSTRUCTIONS .................................................... 12
    10.1 Automatic Launching of the Installation Program ............................... 13
    10.2 Manual Launching of the Installation Program ..................................... 14
    10.3 Welcome Screen ............................................................................. 14
    10.4 Setup Configuration ........................................................................... 15
    10.5 .NET Framework Installation .............................................................. 16
    10.6 SQL Server ..................................................................................... 16
    10.7 Crystal Reports Installation .............................................................. 18
    10.8 DGH Scanmate Drivers ..................................................................... 19
    10.9 DGH Scanmate Installation .............................................................. 21
    10.10 DGH Scanmate License Agreement Window ...................................... 22
    10.11 Selecting an Installation Folder ....................................................... 22
    10.12 Installation .................................................................................... 23
    10.13 Database Configuration ................................................................. 24
11. INSTALLATION OF SCANMATE DRIVERS ...................................................... 28
    11.1 Connecting USB Interface Module ...................................................... 28
    11.2 Found New Hardware Wizard ............................................................. 28
    11.3 Automatically Install Drivers ............................................................... 29
    11.4 Windows Logo Testing ..................................................................... 29
    11.5 Complete Installation of Drivers .......................................................... 30
    11.6 Further Driver Installation ................................................................. 30
12. STARTING THE SCANMATE SOFTWARE ....................................................... 31
    12.1 Launching the Application ................................................................. 31
    12.2 Splash Screen ............................................................................... 31
    12.3 Login Screen ............................................................................... 31
    12.4 No USB Devices Detected Warning ................................................... 32
13. CONFIGURING THE SCANMATE SOFTWARE .................................................. 33
    13.1 System Preferences ....................................................................... 33
    13.2 Operator Preferences .................................................................... 35
    13.3 Doctor Preferences ................................................................... 37
14 THE PATIENT DATA SCREEN
14.1 Patient Data Screen Controls
14.2 Entering a New Patient
14.3 Searching for a Patient
14.4 Editing a Patient Record
15 THE A-SCAN SCREEN
16 THE B-SCAN SCREEN
16.1 Selecting the Probe
16.2 Adjusting Pulse Power
16.3 Selecting the Operator
16.4 Selecting OD or OS
16.5 Starting / Stopping the Scan
16.6 Adjusting Image Controls
16.7 Saving Operator Settings
16.8 Video Controls
16.9 Diagnostic A-Mode
16.10 Adding Exam Comments
16.11 Caliper Tool
16.12 Zoom
16.13 Selecting Probe Orientation
16.14 Saving B-Scan Images
16.15 Saving B-Scan Videos
16.16 Reviewing B-Scan Exams
16.17 Performing a B-Scan Exam
17 THE IOL CALCULATOR SCREEN
18 CREATING REPORTS
18.1 B-Scan Report
18.2 Using Reports
18.3 Opening Reports
19 DATABASE MANAGEMENT
19.1 Backing Up the DGH-Scanmate Database
19.2 Restoring the DGH-Scanmate Database
19.3 Copying or Moving the Database
19.4 Deleting a Database
19.5 Attaching an Existing DGH-Scanmate Database to a DGH Database Server
19.6 Importing and Exporting Data
19.7 Importing Legacy Files (.bs or .cini)
19.8 Configuring Firewall for DGH Database Server
20 ELECTROMAGNETIC COMPATIBILITY
21 CLEANING AND DISINFECTION
21.1 Probe Cleaning
21.2 Probe Disinfection
1 General Device Description

The DGH 8000 is a diagnostic ultrasound device used by professionals in the ophthalmic field to produce cross-sectional images of the eye and orbit. The probe is comprised of a 12 MHz, single element transducer that is mechanically oscillated to perform a 60 degree sector scan of the eye. The probe hand piece contains the electronics used to pulse the transducer as well as to measure, filter and amplify the resulting echoes from intraocular and orbital tissue. The probe is powered and controlled via a USB 2.0 cable, which must be connected to a PC or Laptop running the Scanmate software. The Scanmate software interprets the digital signals transmitted by the probe and displays a “Brightness Scan” that shows the relative magnitude of the echo spikes received by the transducer. The software allows the user to adjust the scan rate of the probe (12 or 15 MHz) as well as the gain, contrast, intensity, and depth of the displayed image. Once the exam is complete, the application allows the user to save video(s), image(s) or create a report to document the results.

2 Device Classification

Device: System, Imaging, Pulsed Echo, Ultrasonic
Panel: Radiology
Product Code: IYO
Device Class: II
Regulation Number: 21 CFR 892.1560

3 Indications for Use

The DGH 8000 Scanmate-B is an ultrasonic device used by professionals in the ophthalmic field to perform a “Brightness Scan” of the eye. The main function of the device is to produce cross-sectional images of the eye and orbit and to serve as an aid in the detection and assessment of physical and functional abnormalities using established diagnostic criteria.
4 Warnings and Cautions

4.1 Meaning of Signal Words

In this manual, the signal words “Warning” and “Caution” are used to highlight important safety and usage instructions. All users of the DGH 8000 must understand the meanings of these signal words.

<table>
<thead>
<tr>
<th>Signal Word</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![WARNING]</td>
<td>Indicates a potentially hazardous situation which if not avoided could cause injury or harm to the equipment or erroneous results.</td>
</tr>
<tr>
<td>![CAUTION]</td>
<td>Indicates a potentially hazardous situation which if not avoided may result in minor injury or harm to the equipment.</td>
</tr>
</tbody>
</table>

4.2 Description of Symbols

This symbol indicates the degree of protection against electric shock. The DGH 8000 Scanmate-B is classified as type BF equipment.

This symbol instructs the operator to read the operating manual.

This mark indicates that Notified Body 0120 (SGS United Kingdom Ltd) has certified the management system of DGH Technology, Inc. meets the requirements applicable requirements of 21 CFR 1010 (Performance Standards for Electronic Products: General) and 21 CFR 1050 (Performance Standards for Sonic, Infrasonic, and Ultrasonic Radiation-Emitting Products). The device also conforms to the following International Standards:

- EN 60601-1: Medical electrical equipment – Part 1: General requirements for safety – IEC 60601-1
- NEMA Standard Publication UD-3: Standard for Real-Time Display of Thermal and Mechanical Acoustic Output Indices on Diagnostic Ultrasound Equipment
This symbol indicates that Emergo Europe is the European Authorized Representative for this device.

This symbol indicates that DGH Technology, Inc. is the manufacturer of the DGH 8000 Scanmate-B device. The YYYY under the symbol indicates the year the device was manufactured.

This symbol indicates that the model number of this device is DGH 8000.

This symbol indicates the serial number of the device. YYYY indicates the year of manufacture and XXXX indicates the unit number.

This symbol located on the DGH 8000 indicates that the equipment consists of electronic assemblies and other components that may be subject to Directives 2002/96/EC, 2003/108/EC, and 2002/95/EC of the European parliament, which advises that electrical and electronic devices must not be disposed of as normal domestic refuse. In order to prevent environmental risks or endangerments by non-professional disposal, the disposal of this product, including any accessories, must comply with valid practices as outlined in Directives 2002/96/EC, 2003/108/EC, and 2002/95/EC and local regulations. All electronic components and systems should be returned to Original Manufacturer for disposal.

4.4 General Cautions and Warnings

⚠️ CAUTION

The probe must be cleaned after each use. Cleaning the transducer is an essential step prior to effective disinfection. Follow the manufacturer’s instructions when using disinfectants.

⚠️ WARNING

Do not allow sharp objects, such as scalpels or cauterizing knives, to touch the probe or cables.

⚠️ WARNING

Equipment not suitable for use in the presence of flammable mixtures.
5 Prescription Device Statement

CAUTION

The DGH 8000 is a prescription device and is only to be used by, or under the supervision of, a licensed physician.

6 Operator Qualifications

This DGH 8000 is intended to be used by trained medical professionals. The medical professional operating the DGH 8000 must have a general knowledge of the use of ultrasonic imaging devices and imaging protocols.
7 Use of Ultrasound in Ophthalnic Devices

Ultrasound offers a non-invasive method to examine the interior of solid objects. Ultrasonic pulses consist of sound waves of a frequency level too high to be heard by the human ear. When a sound impulse strikes an interface, some sound is reflected, and some sound is transmitted. Because some sound will pass through the surface and be reflected by the next surface, complex structures can be examined with ultrasound. When ultrasound penetrates an object with several interfaces, the reflected ultrasound can be observed on a display as a “Brightness Scan” that shows the relative position and magnitude of the echo spikes received by the transducer.

Note: Ultrasound cannot travel through air because air is not dense enough for the high frequency waves to propagate. Ultrasonic measurements must therefore be performed by direct contact or through a denser medium such as coupling gel or water.

8 Ultrasonic Exposure and Intensities

8.1 Tissue Exposure to Ultrasound Energy

The ultrasound energy emitted by the DGH 8000 is low intensity and will have no adverse effects on the patient and/or operator. However, the operator is still cautioned to perform examinations using the principle of ALARA (As Low As Reasonably Achievable). All examinations should be done so that the patient receives as little ultrasound radiation as possible. Do not hold the probe against the eye or other tissue with the system activated except when performing an exam. Do not perform unnecessary exams.

8.2 Ultrasonic Intensities

See Appendix B of this manual for acoustic measurements.

9 Biometric Imaging Capabilities

The following table shows the resolution for the DGH 8000 Scanmate-B.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Electronic</th>
<th>Clinical</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>0.015 mm</td>
<td>&lt; 0.1mm</td>
</tr>
</tbody>
</table>
10 Software Installation Instructions

The following section describes the installation process for the Scanmate software. Before proceeding, review Appendix A Computer System Requirements to make sure the computer meets the minimum system requirements for the Scanmate software.

Please consider the desired usage of the DGH 8000 (Scanmate-B) before installation. The data recorded can either be saved on the computer operating the DGH 8000, on a networked computer, or on a server. Deciding whether a system will be used to perform scans, store data, or both will determine which software components should be installed.

**Standalone Operation:** A single computer is used to operate the DGH 8000 B-scan, review the data collected, and store the database.

Networked to a Server: The database is stored on a server on the local network. Any networked computer can be set up to perform scans and review the data collected.
**Networked with other Computers:** Multiple computers perform B-Scans, and all the data is stored in a single database on one of the computers.

Once the desired configuration has been determined, the installation wizard will ensure that only the necessary components are installed on each system.

**Note:** Depending on the security settings of the computer system, the computer may ask for permission at various points during the installation process. Click “Yes” to allow the installer to make the necessary changes to the computer system during installation.

---

**WARNING**

Using “Non-Essential” Software in Conjunction with the Scanmate System Could Have Unknown / Adverse Impact on the Operation of the Device and is Therefore Not Recommended.

---

**10.1 Automatic Launching of the Installation Program**

Insert the Scanmate DVD into the DVD drive of the computer, or connect a USB drive with the Scanmate installation files. If the installation does not start automatically, follow step 10.2 below.
10.2 Manual Launching of the Installation Program

On most systems, the installer launches automatically upon placing the DVD in the DVD drive. In some cases, the Windows system policy may require manual launching of the application.

- Insert the Scanmate DVD or USB drive
- Go to “My Computer”
- Right-click on the DVD / USB drive icon
- Select “Explore”
- Double-click “Setup.exe”

10.3 Welcome Screen

A Welcome Screen will appear at the beginning of the installation. Click the “Next” button to continue with the installation. Click “Cancel” to exit the installation.
10.4 Setup Configuration

There are three possible installation configurations. If the DGH 8000 will be used in a networked environment, the DGH Database Server should be installed on a computer or server before the Scanmate Software is installed on other computers.

The first choice is to “Install the Scanmate Software and Create a New DGH Database Server” on the current computer. This choice will be used for standalone operation. In a networked arrangement, this choice will also be used for the computer that houses the database if that computer will be used to perform B-scans.

Choosing to “Install Scanmate software and Connect to an Existing DGH Database Server” will prepare a computer to operate the B-Scan. The information collected by the B-Scan will be saved on a networked database; the database should already be installed on a network location before selecting this option.

“Create New DGH Database Server” will only install the DGH Database Server. This choice will be used for a server or networked computer that will store patient records but will not be used to perform B-scans.

Click on one of the three icons to select the desired setup option. The setup will begin automatically.
10.5 .NET Framework Installation

The .NET framework is necessary for the proper operation of the DGH Scanmate software. If it is not present, the installer will install the .NET framework before proceeding. Click “Start” to begin. If prompted, click “Next” to install the .NET framework.

If the .Net framework is already present, or when it has completed installing, a success window will appear. Click “Next” to continue.

10.6 SQL Server

Note: If the computer being set up will only be used to perform scans and will not host the database, this step will automatically be skipped by the installer. Please proceed to section 10.7: Crystal Reports.

The DGH-Scanmate database requires SQL Server 2008 R2. The installer will check for the presence of this application. If it is not present, the installer will install the necessary SQL Server 2008 R2 pre-requisites before proceeding. It may be necessary to restart the computer in order to complete the SQL Server installation; if prompted, restart the computer and restart the installation procedure.
If installing SQL Server for the Scanmate application for the first time, an administrator name and password must be created. The server will be named DGHServe. The system administrator log-in name is “sa” by default; please record the password in a secure place.

SERVER NAME  **DGHServe**

LOG-IN NAME  **sa**

PASSWORD  ________________________

**Note:** Please select a strong password. Depending on the security settings of the system, the SQL application may reject a weak password (such as “password”). A strong password contains a mixture of capital and lowercase letters, numbers, and symbols and is at least 8 characters long.

Please review the SQL Server 2008 R2 End User License Agreement (EULA) before continuing. After selecting the “I Agree” button, click the “OK” button to continue.
10.7 Crystal Reports Installation

Note: If the computer or server being set up will only be used to host the database and will not perform B-scans, this step will automatically be skipped by the installer.

Crystal Reports 2008 is a pre-requisite used by the Scanmate software to create and view reports.
Click “Start” to begin installation. The installer will provide a notification when finished; click “Next” to continue.

### 10.8 DGH Scanmate Drivers

**Note:** If the computer or server being set up will only be used to host the database and will not perform B-scans, this step will automatically be skipped by the installer.

Click “Start” to install the DGH Scanmate drivers. The installer will now install the drivers to operate the DGH 8000. All DGH devices must be disconnected from the USB port(s) during the driver installation process. A warning window will appear as a reminder.
When the drivers have been installed, a success window will appear. Clicking “Next” will conclude all prerequisite installations.

To continue with installation of the DGH Scanmate software, click the “Install Scanmate” button.
10.9 DGH Scanmate Installation

**Note:** If the computer or server being set up will only be used to host the database and will not perform B-scans, this step will automatically be skipped by the installer.

The DGH Scanmate Setup Wizard will launch automatically once the prerequisites have been successfully installed.

![DGH Scanmate Setup Wizard](image)

Click “Next” to continue.

**Note:** If the DGH Scanmate program has already been installed on the current computer, it will be detected. The Setup Wizard will be able to repair many installation problems; it can also uninstall the DGH Scanmate to allow a new “clean” installation. A choice will be offered to repair or remove the Scanmate program. Select either Repair or Remove and click “Finish”.

10.10 DGH Scanmate License Agreement Window

**Note:** If the computer or server being set up will only be used to host the database and will not perform B-scans, this step will automatically be skipped by the installer. Please proceed to section 10.13: Database Configuration.

Please review the End User License Agreement (EULA) before continuing. After selecting the “I Agree” button, click the “Next” button to continue.

![License Agreement Window](image)

10.11 Selecting an Installation Folder

**Note:** If the computer or server being set up will only be used to host the database and will not perform scans, this step will automatically be skipped by the installer.

By default, the Scanmate software will be installed in the “C:\Program Files\DGH Technology, Inc\DGH Scanmate” folder. If a different location is desired, it can be selected here. On computers with multiple users, the software can be made either available to all users, or only available to the current user logged in during the installation. Click “Next” to continue.

![Select Installation Folder](image)
10.12 Installation

**Note:** If the computer or server being set up will only be used to host the database and will not perform B-scans, this step will automatically be skipped by the installer.

During installation, a progress bar will appear in the installation dialog box. When the installation has finished successfully, it will be replaced by an “Installation Complete” announcement. Click “Close” to exit the installer.

A new shortcut will now appear on the desktop. Please complete the configuration steps before launching the Scanmate application.
10.13 Database Configuration

After successful installation, a configuration dialog will automatically launch. This establishes how the Scanmate software will connect with the SQL database. Click “Start” to begin.

Select the DGH Database Server you wish to connect to in the combo box. If no database servers are listed, select “Browse For More” to get a list of all available DGH Database Servers. Enter the administrator password created in section 10.6 and click the “Connect” button. When the Connection Status shows “Connected”, click the “Next” button.
**Note:** When sharing the database over a network, make sure the firewall on the computer hosting the database has been configured to allow access to SQL Server. Client computers will be unable to connect to the database unless this is done. See section 19.8 for details on firewall configuration.

**Note:** In order to connect to the SQL database server over a network, both the computer hosting the database and the client computer must be in the same Workgroup or Domain.

Once connected to the SQL Server, click the Next button. A database can now be created. If a DGH-Scanmate database already exists, the installer will configure the DGH Scanmate application to connect to the existing database.

If a prior database version exists, select “Update DB” to update it to the latest version.
The following message may appear if the DGH Database Server was previously uninstalled and the database was not removed. If the database contains files that should be retained, refer to section 19.5 “Attaching an Existing DGH-Scanmate Database to a DGH Database Server”. If the previous database is not wanted, delete it before proceeding.

Click on “Create DB” to continue.

After successful database creation, a notification screen will appear. Click “Next” to continue.
A database user must be created. A single log-in will be used for all users of the computer system.

![Image of a software interface for creating a SQL login]

To avoid being accidentally locked out of the system, it is recommended that the user name and password be written down in a secure location.

**USER NAME** ______________________

**PASSWORD** ______________________

Note: Please select a strong password. A strong password contains a mixture of capital and lowercase letters, numbers, and symbols.

![Image of a window confirming configuration completion]

Click “Save” to save the configuration settings. A final window will appear to confirm that the configuration was completed successfully.
11 Installation of Scanmate Drivers

In order to complete the driver installation, connect the DGH 8000 Probe to an available USB 2.0 port. The drivers will automatically be installed. If this does not happen, the steps below will ensure correct installation of the DGH Scanmate drivers.

Note: The following steps may vary depending on the version of the Windows Operating System being used.

11.1 Connecting USB Interface Module

Connect the DGH 8000 Probe to an available USB 2.0 port.

11.2 Found New Hardware Wizard

Once plugged in, the “Found New Hardware Wizard” should appear automatically. If the “Found New Hardware Wizard” does not appear, launch the “Add New Hardware Wizard” manually. The Add New Hardware Wizard can be launched in Control Panel or by typing “hdwwiz” into the search box in the start menu.

Do not use Windows Update to search for software. Select the “No, not this time” option and press the Next button.

![Found New Hardware Wizard](image.png)
11.3 Automatically Install Drivers

Select the “Install the software automatically (Recommended)” option. Click the “Next” button to continue with the installation.

11.4 Windows Logo Testing

During the installation process, the “Windows Logo testing” warning screen may appear. Click the “Continue Anyway” button to continue with the installation.
11.5 Complete Installation of Drivers

After successful driver installation, the “Completing the Found New Hardware Wizard” window appears. Click the “Finish” button to complete the installation.

11.6 Further Driver Installation

The DGH Scanmate has two sets of drivers. The second set of drivers will be installed the first time the Scanmate application is launched.

Note: You must install the drivers for each USB port you wish to use the Scanmate product(s) with. It is recommended that you install the drivers on each USB port of the computer at this time, following the steps above.
12 Starting the Scanmate Software

12.1 Launching the Application

Once installed, the “DGH Scanmate” shortcut appears on the Windows desktop and in the start menu. Click on the desktop icon to start the DGH Scanmate application.

12.2 Splash Screen

The Scanmate splash screen will appear while the application loads.

12.3 Login Screen

A single username and password is used to gain access to the software and database for all users. By default, the Scanmate software is set to automatically log in when the application is started using the username and password specified in System Preferences. To change this setting, uncheck the “Automatic Login” preference in the System Preferences menu. If a login is requested, enter the username and password created in section 10.13.
12.4 No USB Devices Detected Warning

If the USB probe is not attached, a warning box will appear.

![Warning](image)

Clicking “OK” will complete the log-in and allow the Scanmate software to be used without the USB probe. Although no scans can be completed, the software can still be used to review B-Scan images, videos and reports.

If the Scanmate software is being used without the DGH 8000 probe attached, the software will require probe key authentication before using, and after every 20 hours of use. Warnings will appear every hour after 15 hours of use. To provide authentication, plug a DGH 8000 probe into a USB port; authentication will complete in a few seconds.
13 Configuring the Scanmate Software

13.1 System Preferences

The “System Preferences” window provides controls to set various configuration items for the system. The System Preferences window can be accessed by selecting Preferences → System from the Menu Bar.

![System Preferences Window]

**Note:** Please refer to the DGH 6000 Scanmate-A User Guide for information on configuring A-Scan related System Preferences.

The **Automatically Start With New Patient** checkbox allows the user to select if the program starts with a new patient or if the user is required to search for a patient upon program startup. When the checkbox is enabled the program will begin a new patient file upon system startup.

The **Automatic Login** checkbox allows the user to select if login is required upon system startup or if the user is automatically logged in. By default this checkbox is enabled, indicating that the username and password will be entered automatically.

The **Report PDF Export Location** setting allows the user to specify the default directory that pdf reports will be exported. The default directory can be any local or mapped network drive.
The “Database Location” textbox specifies the location of the DGH Database Server hosting the DGH-Scanmate database. To change the Database Server that the DGH Scanmate application connects to, select the “Change Configuration” button and follow the steps described in section 10.13.

The “Database Name” textbox displays the name of the DGH-Scanmate database. The default database name is created automatically when installing the system and is not user configurable.

The “Username” textbox displays the username that the Scanmate application uses to connect to the database. To change the username, select the “Change Configuration” button and follow the steps described in section 10.13.

The “Password” textbox displays the password that the Scanmate application uses to connect to the database. To change the password, select the “Change Configuration” button and follow the steps described in section 10.13.

The “Hint” textbox allows the user to enter a hint for the password. If a user is logging in manually, clicking the “Show Hint” button at log-in will display the hint text. To change the hint, select the “Change Configuration” button and follow the steps described in section 10.13.
13.2 Operator Preferences

The “Operator Preferences” window provides controls to identify Operators and configure their preferences. The Operator Preferences window can be accessed by selecting Preferences → Operator from the Menu Bar.

![Operator Preferences Window](image)

**Note:** Please refer to the DGH 6000 Scanmate-A User Guide for information on configuring A-Scan related Operator Preferences.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>The “New” button allows the user to create new operators and assign preferences to the newly created operator.</td>
</tr>
<tr>
<td>Edit</td>
<td>The “Edit” button allows the user to make changes to an existing operator’s preferences. To change an operator’s preferences, click the “Edit” button while the desired operator’s name is selected in the “Name” combo box. Changes to operator preferences are saved by clicking the “Apply” button, or can be discarded by clicking “Cancel”. The “OK” button will save the current settings and close the “Operator Preferences” window.</td>
</tr>
<tr>
<td>Delete</td>
<td>The “Delete” button will delete an operator from the system. When clicked, the user is prompted for confirmation prior to deleting the operator’s preferences.</td>
</tr>
</tbody>
</table>
The “Name” combo box selects an existing operator from the database to view, edit, or delete their preferences. Selecting an operator’s name will display that operator’s preferences on the screen.

The “Notes” textbox allows the user to associate notes to an operator’s preferences.

The B-Scan “Video Playback Speed” slide bar adjusts the frames per second (fps) that the B-Scan video is played for the currently selected operator. The speed of video playback can be adjusted from 1 to 20 fps.

The B-Scan “Video Buffer Frames” slide bar adjusts the size of the buffer used when capturing B-Scan video. Moving the slide bar from left to right increases the number of frames stored in the buffer. Increasing the number of frames that can be stored in the buffer allows the user to determine the amount of video that is captured before it begins to overwrite itself. The video buffer can be configured to store from 16 to 256 frames.

When the “Save Video On Stop Scan” checkbox is selected, the B-Scan video will automatically be saved when the scan is stopped.

When the “Save Image On Stop Scan” checkbox is selected, the last B-Scan frame will automatically be saved when the scan is stopped.

The “Display Control Values” checkbox allows the user to select whether or not the Gain, Intensity and Contrast control values are displayed in the B-Scan image window.

When the “Bidirectional Scan” checkbox is selected, the B-Scan probe will acquire image information in both sweep directions.

The “Average” preference turns on the frame-to-frame B-Scan averaging algorithm. For slower processors, averaging can be turned off to improve display performance at the expense of image quality.

The “Interpolate” preference enables or disables the linear interpolation algorithm. For slower processors, interpolation can be turned off to improve display performance at the expense of image quality.
13.3  Doctor Preferences

The “Doctor Preferences” window provides controls for the user to identify Doctors and configure their preferences. Doctor Preferences define the default protocol for performing A-Scans and IOL Calculations. The Doctor Preferences window can be accessed by selecting Preferences → Doctor from the Menu Bar.

![Doctor Preferences Window]

**Note:** Please refer to the DGH 6000 Scanmate-A User Guide for information on configuring A-Scan related Doctor Preferences.

The “New” button allows the user to create new doctor profiles and assign preferences to the newly created doctor.

The “Edit” button allows the user to make changes to an existing doctor’s preferences. The user can change a doctor’s preferences by clicking this button while the desired doctor’s name is selected in the “Name” combo box.

The “Delete” button deletes a doctor from the system. When clicked, the user is prompted for confirmation prior to deleting the doctor’s preferences. Once deleted, the doctor will still exist in the database, but will be marked as inactive.

The “Name” combo box selects an existing doctor from the database to view, edit, or delete their preferences. The “Default Doctor” checkbox selects which doctor will be automatically placed on the Patient Data and IOL Calculator Screens. If only one doctor exists, that doctor is automatically set as the default doctor.

The “Notes” text box is provided to allow the user to associate notes to a doctor’s preferences.
14 The Patient Data Screen

The Scanmate application will automatically open the Patient Data Screen upon startup. The Patient Data Screen allows the user to Create, Review and Edit patient records.

By default this screen will open in Search Mode. It is also possible to configure the Patient Data Screen to automatically open a new blank patient record each time the program is launched. To change this setting, select the “Automatically Start with a New Patient” preference in the System Preferences menu.

14.1 Patient Data Screen Controls

The Patient Data Screen operates in three distinct modes of operation: “Search and View”, “Edit / Save Data”, and “New Patient.” The action buttons on the top right hand side of the screen change availability depending on the current mode of the Patient Data screen. The patient data screen buttons include:

- New
- Search
- Edit / Save
- Undo
The “New” button is used to enter new patients in the DGH-Scanmate database. When clicked, the “Last Name”, “First Name”, and “ID#” combo boxes change to plain text boxes and allow the user to enter a new patient.

The “Search” button is used to search for patients in the DGH-Scanmate database. When selected, the “Patient Info” controls are closed for editing and all combo boxes become auto-suggest fields.

The “Edit” button is used to edit patient records in the DGH-Scanmate database. When selected, the “Patient Info” and “Pre-Operative” controls become enabled for editing. The Pre-Operative and Post-Operative data is only needed for performing IOL power calculations.

The “Save” button saves New or Modified patient records to the DGH-Scanmate database.

The “Undo” button allows the user to undo the last changes that were made to the Patient’s Record. All fields will revert to the most recent saved state.

14.2 Entering a New Patient

Select the “New” button and enter the following required fields:

- Last Name
- First Name
- ID Number

The ID Number must be unique for each patient. The Scanmate Software will prevent a new patient from being saved to the database if a patient with the same ID Number already exists. A default unique ID number is created based on the date and time the new patient is entered; this can be replaced with any other numbering system desired. The Patient’s Last Name, First Name and ID Number are required fields and must be entered before the record can be saved.

The following optional fields can also be entered at this time:

- Patient Date of Birth
- Patient Gender
- Doctor
- Comments
- K1 and K2 (Only Needed for IOL Calculations)
- Desired Refraction (Only Needed for IOL Calculations)

Select the “Save” button once all of the desired fields have been entered.
14.3 Searching for a Patient

Select the “Search” button to search for a patient record that has been saved in the database. Patients can be searched for by Last Name, First Name, or by ID Number.

To search by Last Name, type the first few letters of the patient’s last name in the Last Name field. The software will automatically show all the results that match the letters that have been typed. The desired Last Name can then be selected from this list. If there is more than one patient in the database with the selected Last Name, the desired patient can be selected using either the First Name and ID Number fields. Only patients that have the currently selected Last Name will be available in these fields.

To search by ID Number, type the desired ID number into the ID Number field. Alternatively, the ID Number can be selected from the dropdown list. Once the desired ID Number has been selected, the unique patient associated with that ID will appear on the screen.

Once a patient record has been loaded, the Procedures associated with that record can be searched by selecting the Procedure list box.

14.4 Editing a Patient Record

Select the desired patient record to be edited following the steps described in section 14.3. Once the patient record has been loaded, select the “Edit” button. All of the editable fields will change from read-only fields to white, editable text boxes. Once the desired changes have been made, select the “Save” button to save the changed record.
15  **The A-Scan Screen**

The A-Scan Screen allows the user to perform and review A-Scan Measurements for the currently selected patient. Please refer to the DGH 6000 Scanmate-A User Guide for instructions on using the A-Scan features of this program.
16 The B-Scan Screen

The B-Scan Screen allows the user to perform and review B-Scan exams for the currently selected patient. Refer to section 14 for details on how to load or create patient records.

The default settings for this page are dependent on the currently selected Operator. The default settings can be changed by selecting Preferences → Operator.

16.1 Selecting the Probe

Select the desired probe from the list of available probes in the Probe Type combo box. The available Pulse Frequencies will be displayed for the selected probe. The Depth selection adjusts the depth of the displayed B-Scan image.

Note: Pulse Frequency is the rate that the probe is electronically pulsed. It is not the resonant frequency of the transducer crystal.
16.2 Adjusting Pulse Power

The Pulse Power slider adjusts the amount of energy used to pulse the transducer element in the probe. Adjusting the pulse power allows the user to distinguish between tissues with different acoustic densities. Exams are typically performed at the highest Pulse Power unless the image is saturated and better definition between tissue structures is desired.

16.3 Selecting the Operator

The name of the Operator performing the measurement can be selected using the Operator dropdown box at right. If the operator is not listed in the drop down box, add the new operator by selecting Preferences → Operator → New.

16.4 Selecting OD or OS

The eye currently being examined (OD or OS) can be selected by pressing the Change Eye button. The currently selected eye is shown in the top left hand corner of the B-Scan display.

16.5 Starting / Stopping the Scan

Use the Blue Button on the Scanmate-B probe to start and stop the scan. The Space Bar or the Start Scan button can also be used.

16.6 Adjusting Image Controls

The three Gain Controls allow you to adjust the near, middle or far field gain of the displayed image. These sliders control gain in the imaging software, not the probe itself.

The Intensity Control adjusts the overall intensity, or brightness, of the image.

The Contrast Control adjusts the overall contrast of the image. Adjust this control to increase or decrease the amount of contrast between light and dark areas of the image.
16.7 Saving Operator Settings

The current image control settings (Gain, Intensity, Contrast) can be saved to the active operator by selecting the **Save Settings** button. Whenever the operator is selected, the image controls will default to the saved settings.

16.8 Video Controls

Use the video controls to review the scan. When paused, use the slider bar to sweep through the video manually, or use the keyboard arrow keys to move frame by frame.

16.9 Diagnostic A-Mode

Select the A-Mode checkbox to enable the diagnostic A-Scan overlay. Use the scroll bar on the right of the image to select the desired A-scan vector.
16.10 Adding Exam Comments
Select the Comments checkbox to enter comments. The comments box can be dragged to any location on the image.

16.11 Caliper Tool
To use the Caliper Tool, right-click and drag the mouse across the image. A second caliper can be selected by clicking “B” in the caliper selection box. The caliper measurement values are displayed in the bottom left corner of the scan image.

16.12 Zoom
Double-clicking on the image allows you to Zoom into an area of interest. The amount of zoom is displayed in the top left corner of the display. A single left-click returns the image to normal resolution.
16.13 Selecting Probe Orientation

The position map allows the user to easily record the probe orientation along with the saved B-Scan image or video.

The images produced by the DGH 8000 represent a 60 degree cross-sectional slice of the globe and orbit. The position map indicates the area of the eye being imaged, not the position of the probe. The marker on the black membrane covering the tip of the probe (as well as the blue start / stop button) corresponds to the top of the displayed image. By convention, the marker is generally aimed either superiorly or nasally.

Axial Probe Positions – An axial scan provides an image of the posterior globe, with the optic nerve centered on the right side of the image. The probe is positioned so that it is centered on the cornea while the patient is looking forward. When properly aligned, the optic nerve will be centered on the right side of the image.

Example of 12:00 AX (VAX) Scan

Use the selection tool to indicate the meridian being scanned, where the yellow marker matches the orientation of the marker on the tip of the probe. Once the
desired position has been selected, use the “Set” button to save the orientation to the current B-Scan Image or Video.

**Longitudinal Probe Positions** – Longitudinal scans provide a radial image from the posterior pole to the anterior periphery. The probe is positioned on the sclera, perpendicular to the limbus, while the patient is looking toward the area of the eye being examined. The probe marker is pointed towards the limbus, causing the optic nerve to be towards the bottom of the image.

![Example of 12:00 L Scan](image)

For a 12:00 Longitudinal scan, the marker on the tip of the probe is pointed toward the area being examined at 12:00. The probe is positioned at 6:00, which is opposite of the area being examined.

Use the selection tool to indicate the meridian being scanned. Once the desired position has been selected, use the “Set” button to save the orientation to the current B-Scan Image or Video.
Transverse Probe Positions – Transverse scans provide a lateral image of the globe that traverses several clock hours. The position of the transverse scan is indicated by the center of the clock hours in the scan as well as the portion of the globe being examined (P for Posterior Pole, E for Equator, EA for Anterior to the Equator, etc.).

Example of 12:00 EP Scan

The probe is positioned on the sclera, parallel to the limbus, while the patient is looking toward the area of the eye being examined. The probe marker is held parallel to the limbus and pointed superiorly during vertical and oblique scans. For horizontal scans (6:00 and 12:00 positions), the marker is pointed nasally to keep it parallel to the limbus.

For a 12:00 EP scan, the probe is positioned at 6:00 with the marker parallel to the limbus and pointed nasally. The probe is pointed toward the Equator Posterior at 12:00.

Use the selection tool to indicate the area of the globe being scanned. Once the desired position has been selected, use the “Set” button to save the orientation to the current B-Scan Image or Video.
Macula Scans

HMAC – A horizontal macula scan (HMAC) is a horizontal axial scan where the probe has been aligned so that it is pointed directly at the macula. The marker on the tip of the probe should be pointed nasally (3:00 OD or 9:00 OS). The optic nerve shadow will be shifted towards the top of the display.

VMAC – A vertical macula scan (VMAC) is a vertical axial scan where the probe has been aligned so that it is pointed directly at the macula. The marker on the tip of the probe should be pointed in the superior (12:00) position.

LMAC – A longitudinal macula scan (LMAC) is a longitudinal scan through the macula where the marker on the tip of the probe is pointed temporally (3:00 OS or 9:00 OD).

TMAC – A transverse macula scan (TMAC) is a vertical transverse scan where the probe has been aligned so that it is pointed temporally (3:00 OS or 9:00 OD), directly at the macula.

16.11 Saving B-Scan Images

B-Scan Images can be saved by selecting the Save Image Button on the upper right hand corner of the B-Scan Screen. This will also save all changes that have been made to the Patient Data since the last save.

Alternatively, the currently loaded image can be saved using the toolbar at the top of the screen by selecting:

File → Save → B-Scan Image

16.12 Saving B-Scan Videos

B-Scan Videos can be saved by selecting the Save Video Button on the upper right hand corner of the B-Scan Screen. This will also save all changes that have been made to the Patient Data since the last save.

Alternatively, the currently loaded video can be saved using the toolbar at the top of the screen by selecting:

File → Save → B-Scan Video
16.13 Reviewing B-Scan Exams

Saved B-scan files can be opened by clicking the Open File button. This will open a window that shows all saved images and videos for the current patient.

![Open File button]

Double-clicking any image or video will open the file in the scan view window.

The Push Pin allows the user to pin the window to the desktop so that it remains visible even after a file has been loaded. Alternatively, the window can be configured so that it closes after a record is loaded.

The window can be configured to show saved records for both eyes (OU) or to only show records for the right (OD) or left (OS) eye.

Records can be deleted by Right-clicking and selecting Delete from the context menu.

The Aspect Ratio of the window (vertical vs. horizontal) can easily be changed. The Scanmate program will remember the size and location of the window the next time it is opened.

Use the Check Box in the top right corner of each thumbnail to include the image in the B-Scan Report.

16.14 Saving B-Scan Images as Jpegs

It is possible to convert saved B-Scan Files to .jpg images so that they can be shared with EMR systems or practitioners that do not have the Scanmate Software. To do this, select the Open File button on the B-Scan screen and drag the image thumbnail(s) to the desired location.

Note: Jpeg files cannot be imported back into the Scanmate program. See section 19 for other import / export options.
16.15 Saving B-Scan Videos as AVI Files

The Scanmate software can convert saved B-Scan videos to AVI files so that they can be used outside of the Scanmate program.

To create an AVI file, first load a B-Scan video from the Scanmate database and select:

File ➔ Export ➔ B-Scan File

Change the file type from BSCAN to AVI in the file type drop down box and select the Save button.

Note: AVI files cannot be imported back into the Scanmate program. See section 19 for other import / export options.

16.16 Creating Reports

Click the Print icon to quickly create a B-scan report. The report will include the patient information, doctor, operator, and date. A window with all the saved images and videos for the current patient will open. Use the checkboxes in the top right corner of each image to include them in the report. The selected images will be shown inserted in a report preview window. Clicking the Add Comments button in the report preview will open a comment box for text entry. Reports can be sent to a printer, saved in the database, or saved as PDF files. For more information on creating reports, see section 18 “Creating Reports”.
16.17 Performing a B-Scan Exam

The ultrasound probe must be cleaned and disinfected before each biometry procedure. (See Section 21 for Cleaning and Disinfection Instructions.)

1. Launch the Scanmate Software Application as described in section 12.

2. Select the “Patient Data” Page and either enter a new patient or select an existing patient.

3. Navigate to the “B-Scan” page and select the eye to be examined (OD or OS) by pressing the “Change Eye” button.

4. Select the desired probe, frequency and depth from the drop down box.

5. Select the name of the Operator performing the measurement. If the operator is not listed in the “Operator” drop-down box, add the new operator by selecting Preferences → Operator → New.

6. Seat or recline the patient in a comfortable position. Use a firm, comfortable head rest to prevent unwanted head movement. Position the DGH Scanmate display so that it is easily visible during the examination.

7. If desired, use the Position Map to indicate the area of the eye being examined.

8. Press the Blue Button on the probe to begin scanning. The Space Bar or the Start Scan button can also be used. The software will begin recording B-Scan frames. The software will start recording over itself once the video buffer has reached the “Video Buffer Frame Size” specified in the Operator Preferences.

9. Direct the patient to look in the desired direction and gently apply the probe directly to the eye or over the eyelid. For best results, an acoustic coupling gel (such as GenTeal) should be used.

10. Once the desired image has been obtained, press the Blue Button on the probe to stop scanning.

11. The image frames captured during the exam can be reviewed on the display by pressing the → or ← cursor keys. The video playback controls can also be used to play back the video of the exam.

12. Use the Gain, Intensity, Contrast and Zoom controls to enhance the quality of the image. If desired, annotate the exam with comments or use the A-Mode & Caliper Tools.

13. Save the desired image(s) or the entire video by selecting the Save Image or Save Video buttons.

14. Repeat the steps above until all the desired regions of the eye have been examined.

15. When the exam is complete, select the “Print” button to create a B-scan report.
17 The IOL Calculator Screen

The IOL Calculator Screen allows the user to perform and review intraocular lens power calculations for the currently selected patient. Please refer to the DGH 6000 Scanmate-A User Guide for instructions on using the IOL Calculator.
18 Creating Reports

Reports can be created for viewing from the Menu Bar. The DGH Scanmate software can produce IOL Calculator Reports, A-Scan Short Reports, A-Scan Custom Reports and B-Scan Reports. Reports can be printed out, saved as PDF files and added to the patient record database. All reports are created with a header that includes the Patient’s Name, ID Number, Doctor and Operator, and identifies the revision of the DGH Scanmate software used to generate the report.

18.1 B-Scan Report

Click the Print icon on the B-Scan Screen to quickly create a B-scan report. A window with all the saved images and videos for the current patient will open.

Use the checkboxes in the top right corner of each image to include them in the report.

The selected images will be shown inserted in a report preview window.

Clicking the Add Comments button in the report preview will open a comment box for text entry.

Select the desired number of images per page using the Image/Page Radio Button.

The colors of the images can be inverted by selecting the Invert Colors checkbox. This helps conserve ink / toner when printing images.
18.2 Using Reports

All types of reports can be printed, browsed, and saved in the same ways.

Clicking the small printer icon in the top left corner will send the report to the printer.

The arrows and page icon next to the printer icon will navigate through the report.

The “Export to PDF” button will save the report as a PDF to the Default Data Directory specified in System Preferences. A browser window will open to allow the user to select the save location and name of the PDF created.

The “Save to DB” button will add the report to the DGH-Scanmate database. Once saved, the report can be retrieved by searching the patient’s name or ID number.

Clicking “Cancel” will exit the report and return to the Scanmate application.

18.3 Opening Reports

To view a previously saved report, select the patient through the Patient Data screen search. Using the Menu Bar, go to

File ➔ Open ➔ Report

A dialog box will display all the saved reports available for that patient. Each report is automatically given a unique name consisting of the type of report, the date it was created, and the time it was created. If more than one report is created within the same minute, these reports will then be numbered 1, 2, 3, etc.

Saved reports can be printed or saved as PDF files.
19  Database Management

Patient data, scan images, measurements, video files, and reports created by the Scanmate application are saved in an DGH-Scanmate database. The database allows patient records to be shared, centralized, or accessed remotely, according to the needs of each biometry department. For example, several operators in a large practice could use several DGH 6000 or DGH 8000 units simultaneously, but all patient records would be stored in a central database. Or, a doctor could perform scans in an examination room, then later access patient records from an office computer.

The database can be backed-up and restored, migrated to another location, or removed.

19.1  Backing Up the DGH-Scanmate Database

Electronic records should be backed up regularly as a safeguard against loss due to computer malfunction, damage, or theft.

1) Open the Back Up / Restore window by selecting:
   File → Database → Back Up / Restore

2) Connect to the DGH Database Server by entering the system administrator password that was created when the DGH Database Server was installed (see section 10.6 for details).
3) Select the desired database to Back Up from the combo box and select the “Back Up” button.

4) Once the back up process has completed, a message box will display the location of the backup file. It is recommended that the backups be performed regularly and stored in a safe location. Preferably, backup files should not be stored on the same physical drive that hosts the database.

19.2 Restoring the DGH-Scanmate Database

If it is necessary to restore a prior database, the back-up version can be reinstalled. Any records added since the date of the last back-up will be lost, so regular back-ups are essential.

1) Open the Back Up / Restore window by selecting:

   File ➔ Database ➔ Back Up / Restore
2) Connect to the DGH Database Server by entering the system administrator password that was created when the DGH Database Server was installed (see section 10.6 for details).

3) Select the desired database to Restore from the combo box and select the “Restore” button.
4) A message box will appear to warn you that the Restore Process will delete the current database. Any data that was saved since the last back up will be lost.

5) Select “Yes” if you wish to continue. The Restore Process will attempt to restore the database from the backup file.

19.3 Copying or Moving the Database

If the database must be moved from its current computer or server location, it can be transferred intact to a new location. It is also possible to create a copy of the database which can be used as a Back Up.

1) Launch SQL Server Management Studio on the computer hosting the database. Management Studio can be found from the Windows Start Menu by selecting:

Programs → Microsoft SQL Server 2008 R2 → SQL Server Management Studio

2) Connect to DGHServer by entering the system administrator password that was created when the DGH Database Server was installed (see section 10.6 for details).

3) It is necessary to “Stop” the DGH Database Server before the database can be copied or moved. Right click on the DGHServer and Select Stop.

Note: This will disconnect all active users from the database and should only be performed when the database is not being actively used.
4) Navigate to the DGH Technology, Inc directory using Windows Explorer. This can typically be found at: C:\Program Files\DGH Technology, Inc.

5) **Copy** the “Data” folder and **Paste** it in the desired location. For back-up purposes, this folder can be stored anywhere, though preferably on a separate physical drive. If you plan to use the database on a different computer, the “Data” folder must be placed in the DGH Technology, Inc folder that was created when the DGH Database Server was installed on that computer. See section 19.5 for details on attaching the database to a new instance of the DGH Database Server.

6) To continue to use the database on the original computer, the DGH Database Server must be restarted. In Management Studio, right click on DGHServ and Select **Start**.
19.4 Deleting a Database

The following steps describe how to permanently delete the DGH-Scanmate database.

**WARNING**

Be certain that the database has been successfully moved or backed-up before performing removal. Removing the database without backing-up will result in data loss.

1) Launch SQL Server Management Studio on the computer hosting the database. Management Studio can be found from the Windows Start Menu by selecting:

   **Programs → Microsoft SQL Server 2008 R2 → SQL Server Management Studio**

2) Connect to DGHServer by entering the system administrator password that was created when the DGH Database Server was installed (see section 10.6 for details).
3) Expand Databases, right click on **DGH-Scanmate** and select **Delete**.

![Image of SQL Server Management Studio](image)

### 19.5 Attaching an Existing DGH-Scanmate Database to a DGH Database Server

Moving the DGH-Scanmate database or re-installing the DGH Database Server will require the DGH-Scanmate database to be re-attached to the DGH Database Server.

1) Launch SQL Server Management Studio on the computer hosting the database. Management Studio can be found from the Windows Start Menu by selecting:

**Programs → Microsoft SQL Server 2008 R2 → SQL Server Management Studio**

2) Connect to DGHServer by entering the system administrator password that was created when the DGH Database Server was installed (see section 10.6 for details).

![Image of Connect to Server](image)
3) Under the DGHServer, right click on Databases Folder and select Attach.

4) The “Attach Databases” dialog window will open. Click the “Add” button.

5) The “Locate Database Files” dialog window will open. Browse to the .mdf file for the old DGH-Scanmate database. If it was installed in the default location, the .mdf file will be in:

C:\Program Files → DGH Technology Inc → Data → DGH Scanmate → DGH-Scanmate.mdf

Select the .mdf file and click the “OK” button.
6) The “Attach Databases” dialog window will now show the DGH-6000.mdf. Click OK.
19.6 Importing and Exporting Data

B-Scan Image and Video files can be imported or exported from the DGH-Scanmate database to be consulted in other locations or by other practitioners.

If both locations have the Scanmate Software (v3.0.0 or later) installed, the best way to exchange B-Scan files is to use the .bscan file format. This format includes all the necessary information to completely identify the patient and to re-create the record in the database. It is also possible to export .jpg images or .avi movies to share with practitioners that do not have the Scanmate Software. See section 16 for more details on exporting these file types.

To export a .bscan file, select:

File ➔ Export ➔ B-Scan File

The currently loaded B-Scan Image or Video will be saved to the selected location.

To import a .bscan file, select:

File ➔ Import ➔ B-Scan File

A browser window will open to select a .bscan file to open. Once opened, the file will load the Patient Data and B-Scan information into the Scanmate program. The opened file can be saved in the database at this point.
19.7 Importing Legacy Files (.bs or .cini)

It is possible to import .bs and .cini files from prior versions of the Scanmate-B software.

To import a .bs or .cini file, select:

File → Import → B-Scan File

A browser window will open to select a .bs or .cini file to open. Because these files don’t contain all the necessary information to be included in the DGH-Scanmate database, a dialog window will open requesting additional information when importing these file types.

Select the Patient that you would like to associate the imported file with. If the desired patient is not shown, select Cancel and add the patient to the database. Verify that the Eye (OD or OS) and the Scan Date are correct and select Import.

Once opened, the file will load the Patient Data and B-Scan information into the Scanmate program. The opened file can be saved in the database at this point.
19.8 Configuring Firewall for DGH Database Server

When sharing the database over a network, the firewall of the computer hosting the database must be configured to allow access to SQL Server. Client computers will be unable to connect to the database unless this is done. Note: opening ports in your firewall may make your computer less secure and increase the risk of it being exploited by malicious software.

The following procedure describes the necessary steps for configuring the firewall to allow access to a DGH Database Server that is being hosted on Microsoft Server 2003, 2008, Windows Vista, Windows 7 or Windows 8.

1) On the Start menu of the computer / server hosting the database, click Run, type WF.msc, and then click OK.

2) Right-Click on Inbound Rules and select New Rule.
3) Select **Port** and then **Next**.

![Image of New Inbound Rule Wizard](image1.png)

4) Select **TCP** and **Specific Local Ports**. Enter port number **1433** and then select **Next**.

![Image of Protocol and Ports](image2.png)
5) Select **Allow the connection** and then select **Next**.

6) Select the network profiles where you want this rule to apply and then select **Next**.
7) Enter a name for this Rule and then select \textbf{Finish}.

8) Open \textbf{UDP} port \textbf{1434} by repeating the steps above, and selecting UDP instead of TCP and entering 1434 instead of 1433 in step number 4.
Configuring DGH Database Server to Use the Static Port defined above

1) Launch SQL Server Configuration Manager and Expand “SQL Server Network Configuration”. Select Protocols for DGHServer.

![SQL Server Configuration Manager](image)

2) Right-Click on TCP/IP and select Properties.

3) Select the IP Addresses Tab and Scroll down to IPAll.

4) **Delete** the “0” from TCP Dynamic Ports field and enter 1433 in the TCP Port field.
5) Select “OK” and Acknowledge the pop-up message instructing you that the SQL server must be restarted for the changes to apply.

6) Left-Click on **SQL Server Services** in the left hand console panel.
7) Right-Click on **SQL Server (DGHServe)** in the right hand details pane and select **Restart**.
20 Electromagnetic Compatibility

Like other medical equipment, the DGH 8000 Scanmate-B requires special precautions to ensure electromagnetic compatibility with other electrical medical devices. To ensure electromagnetic compatibility (EMC), the DGH 8000 must be installed and operated according to the EMC information provided in this manual.

The DGH 8000 has been designed and tested to comply with EN 60601-1-2 requirements for EMC with other devices.

---

**Guidance and Manufacturer’s Declaration: Electromagnetic Emissions & Immunity**

The DGH 8000 Probe is intended for use in the electromagnetic environment specified below. The customer or the user of the USB Ultrasound Probe should ensure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Environmental Phenomena</th>
<th>Test In Accordance to</th>
<th>Level</th>
<th>Criteria</th>
<th>Basic Standard</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radiated Emissions</td>
<td>EN60601-1-2</td>
<td>Group 1</td>
<td>Under Limit</td>
<td>CISPR 11</td>
<td>Measure at 5 meters</td>
</tr>
<tr>
<td>Electrostatic Discharge</td>
<td>EN60601-1-2</td>
<td>±2Kv ±4Kv ±8Kv contact discharge</td>
<td>36.202.1 (j)</td>
<td>EN61000-4-2</td>
<td>Apply to all accessible components</td>
</tr>
<tr>
<td></td>
<td></td>
<td>±2Kv ±4Kv ±8Kv air discharge</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Radiated Immunity</td>
<td>EN60601-1-2</td>
<td>80MHz-2.5GHz 3V/m 80%@1kHz</td>
<td>36.202.1 (j)</td>
<td>EN61000-4-3</td>
<td>Expose all parts of EUT to field</td>
</tr>
<tr>
<td>EFT I/O Only</td>
<td>EN60601-1-2</td>
<td>±2Kv 5/50 5kHz</td>
<td>36.202.1 (j)</td>
<td>EN61000-4-4</td>
<td>None</td>
</tr>
<tr>
<td>Conducted Immunity I/O Only</td>
<td>EN60601-1-2</td>
<td>0.15 – 80MHz 3Vrms 80%@1kHz</td>
<td>36.202.1 (j)</td>
<td>EN61000-4-6</td>
<td>None</td>
</tr>
</tbody>
</table>

---

! **CAUTION**

Portable and mobile RF communications equipment may affect the normal function of the DGH 8000 Scanmate-B.

! **CAUTION**

Do not use cables or accessories other than those provided with the DGH 8000 Scanmate-B, as they may result in increased electromagnetic emissions or decrease immunity to such emissions.
Guidance and Manufacturer’s Declaration: Electromagnetic Immunity

The DGH 8000 Scanmate-B is intended for use in the electro-magnetic environment specified below. The customer or the user of the DGH 8000 should ensure that it is used in such an environment.

Field strength from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, armature radio, AM and FM radio broadcast and TV broadcast, cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the DGH 8000 is used exceeds the applicable RF compliance level, the DGH 8000 should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as reorienting or relocating the DGH 8000.

21 Cleaning and Disinfection

WARNING

Users of the DGH 8000 Scanmate-B have an obligation and responsibility to provide the highest degree of infection control possible to patients, co-workers and themselves. To avoid cross contamination, follow all infection control policies established for the office, department or hospital as they apply to personnel and equipment.

WARNING

Always disconnect the DGH 8000 from the host computer before performing maintenance or cleaning.

Always follow the manufacturer’s instructions when cleaning and disinfecting probes.

Do not use a surgeon’s brush when cleaning probes. Even the use of soft brushes can damage the probe.
21.1  Probe Cleaning

1. Wear protective gloves when performing the cleaning process.
2. Disconnect the probe from the system.
3. Use a soft cloth lightly dampened in a mild soap or compatible cleaning solution to remove any particulate matter or body fluids that remain on the probe or cable.
4. To remove remaining particulates, rinse with water up to the blue strain relief where the USB cable enters the probe. Do not immerse the strain relief or USB cable.
5. Wipe with a dry cloth; or wipe with a water-dampened cloth to remove soap residue, and then wipe with a dry cloth.

21.2  Probe Disinfection

The following disinfectants are recommended due to their biological effectiveness as well as their chemical compatibility with the DGH 8000 materials.

<table>
<thead>
<tr>
<th>Solutions</th>
<th>Country</th>
<th>Type</th>
<th>Active ingredient</th>
<th>FDA 510(k)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cidex®</td>
<td>USA</td>
<td>Liquid</td>
<td>Gluteraldehyde</td>
<td>K934434</td>
</tr>
<tr>
<td>Cidex Plus®</td>
<td>USA</td>
<td>Liquid</td>
<td>Gluteraldehyde</td>
<td>K923744</td>
</tr>
</tbody>
</table>

1. Wear protective gloves when performing the disinfecting procedure.
2. Check the expiration date on the solution that is being used. Use only solutions that are within the expiration date.
3. Mix the disinfection solution compatible with the probe according to label instructions for solution strength. A disinfectant qualified by the FDA 510(k) process is recommended.
4. Immerse the tip of the probe approximately 1.5 cm in the disinfection solution. Avoid immersion beyond the membrane / probe interface.
5. Follow the instructions on the disinfection label for the duration of probe immersion.
6. Using the instructions on the disinfectant or sterilization label, rinse the probe up to the point of immersion, and then air dry or towel dry with a clean cloth.
7. Examine the probe for damage such as cracks, splitting, fluid leaks, or sharp edges or projections. If damage is evident, discontinue use of the probe and contact a customer service representative.
WARNING

DGH makes no claims about the biological effectiveness as a disinfectant of any of the products listed above. Furthermore, DGH makes no claims regarding the effectiveness of any of these products for killing any known, or unknown, bacteria, virus, or other micro-organisms. DGH only claims that these products, when used properly, will not harm the probe tip.

WARNING

It is the responsibility of the user to remain current with the latest information from the relevant disinfectant manufacturer concerning instructions, effects, necessary concentrations, immersion times and rinse requirements.

WARNING

Using a non-recommended disinfectant, incorrect solution strength, or immersing the probe tip deeper than described in step #4 (above), or for a period longer than recommended can damage or discolor the probe and will void the probe warranty.

Do not immerse the probe tip for longer than one hour. The probe may be damaged by longer immersion times.

Disinfect the probe tip using only the liquid solutions. Using autoclave, gas (EtO), or other non DGH Technology approved methods will damage the probe and void the warranty.
22 Care and Maintenance

22.1 Care of the USB Probe

The USB probe is a completely sealed unit. The probe may be submersed in water up to the cable during normal use.

⚠️ WARNING
Do Not Attempt To Open the Probe Housing

The probe should be cleaned after every use. See the “Cleaning and Disinfecting” section for more details.

Regularly check the front face of the probe for cracks, as this may cause a loss of fluid, which would impair the performance of the probe.

Be sure to keep the USB connector dry at all times.

Regularly check the USB cables for cuts cracks and kinks. The presence of these defects can impair the performance of the device.

⚠️ WARNING
Do Not Attempt to Disconnect or Remove USB Cable from the Probe

22.2 Maintenance of the USB Probe

Periodic testing and maintenance of the USB Ultrasound Probe is NOT required.

22.3 Operating Conditions

The DGH 8000 (Scanmate-B) should be operated within the following conditions:

- Max operating temperature 40°C (104°F)
- Min operating temperature 10 °C (50 °F)
- Operating humidity range 20 - 80% non-condensing
22.4 **Storage**

When the DGH 8000 is not being used, it should be stored in a clean, dry area.

To prevent damage to the DGH 8000, do not store in areas where it might be exposed to:

- Excessive vibration
- Excessive dust and dirt
- Liquids or condensation
- Impact

Store the DGH 8000 under the following ambient conditions:

- **Temperature:** -10°C to 50°C (14°F to 122°F)
- **Relative Humidity:** 20% to 80% (no condensation)
- **Atmospheric pressure:** 70 kPa to 106 kPa

22.5 **Transportation**

Never carry the DGH 8000 by the USB cable.

Never bend the USB cable in a tight radius. This could result in damage to the cable.

Transport the DGH 8000 under the following ambient conditions:

- **Temperature:** -10°C to 50°C (14°F to 122°F)
- **Relative Humidity:** 20% to 80% (no condensation)
- **Atmospheric pressure:** 70 kPa to 106 kPa

When transporting the DGH 8000 to a different field location or when returning it for repair or maintenance, use the original DGH 8000 packing enclosure.

If the original package is not available, pack in such a way that the DGH 8000 is protected.

22.6 **Disposal**

Contact DGH Technology, Inc. before disposing of the DGH 8000.

Concerning the WEEE label, the following information is for EU member states:

The use of this symbol indicates that this product should not be treated as household waste. By ensuring that this product is disposed of correctly, you will help prevent potential negative consequences for the environment and human health, which could otherwise be caused by inappropriate waste-handling of this product. For more information concerning the return and recycling of this product, please consult DGH Technology, Inc.
23 Troubleshooting

If a problem is experienced with the DGH 8000, try the suggestions listed below:

Error During Installation of .Net Framework

- In order to install the .Net framework on Windows SBS Server 2008, the following steps are necessary:
  2. Click on "Features" in the left panel of the Server Manager dialog box.
  3. Click on "Add Features" in the Features panel of the Server Manager dialog box.
  4. Expand the ".NET Framework 3.5.1 Features" in the Select Features dialog box.
  5. In the expanded ".NET Framework 3.5.1 Features" list, check ONLY ".NET Framework 3.5.1" and click the Next button.
  6. Click the Install button on the "Confirm Installation Selections" dialog box.
  7. When the "Installation Results" dialog box appears, click the Close button.

Error During Installation of SQL Server 2008 R2

- Confirm that the user has administrative privileges on the system where SQL Server is being installed.
- If SQL was previously uninstalled, the computer must be restarted before SQL can be installed again.
- Depending on the security settings of the system, the SQL Server installation may fail if a “Strong” password isn’t used. Make sure the system administrator password uses a mixture of capital and lowercase letters, numbers and symbols and is at least 8 characters long (!DGHTest1 is an example of a strong password).

Unable to Connect to DGH-Scanmate Database

- Confirm that the location, user name and password for connecting to the database are correct.
- If the database was moved, or SQL server was re-installed, you will need to re-attach the DGH-Scanmate database to the DGH Database server. See section 19.5 for details.
- If connecting to a database over the network, verify that the computer hosting the database is powered ON and the firewall on the computer hosting the database has been configured to allow access to SQL Server (see section 19.8 for details). In addition, verify that both computers are in the same WORKGROUP or DOMAIN.
Unable to Connect to DGH Database Server

- Confirm that the location (computer name) and password for connecting to the database server are correct.
- If connecting to a database over the network, verify that the computer hosting the database is powered On and the firewall on the computer hosting the database has been configured to allow access to SQL Server (see section 19.8 for details). In addition, verify that both computers are in the same WORKGROUP or DOMAIN.
- If the system administrator password for SQL Server has been lost or forgotten, it will be necessary to reset it using Management Studio.
  1. Launch Management Studio as described in section 19.
  2. Select “Windows Authentication” instead of “SQL Server Authentication”.
  3. Right-Click on the “sa” User Account (found under Security→ Logins) and select Properties.
  4. Enter and confirm the new password.

USB Probe Not Connected

- Confirm that the drivers have been installed for the USB 2.0 port the probe is currently connected to. See section 10.8 for details.
- Confirm that the USB cable is firmly connected to the probe.
- Try connecting the probe to a different USB port on the computer.

Probe Key Expired

- The USB probe must be connected to the PC running the Scanmate application after every 20-hours of use.
- If connecting the probe does not reset the Probe Key, try the steps described in “USB Probe Not Connected” section of the troubleshooting guide.
24 Warranty

DGH Technology, Inc. “DGH” warrants each new DGH 8000 and its accompanying accessories (hereinafter called “Equipment”) to be free from defects in material and workmanship for twelve (12) months from the date of delivery to the original purchaser. This warranty is not applicable to any defect that is the result of an accident, misuse, mishandling, neglect, improper installation, improper repair or improper modification by persons other than DGH. This warranty does not apply if the Equipment has not been operated and maintained in accordance with the operating and maintenance manuals and instructions or bulletins issued in respect thereof by DGH. The cost of servicing replaceable and expendable items including parts and labor made in connection with the routine maintenance services as described in such Operator’s Manual is not covered under this warranty and is the responsibility of the purchaser.

This warranty is strictly limited to replacement or repair of the part that is found to be defective in material and workmanship. At the option of DGH, said part shall be replaced or repaired free of charge, F.O.B. our factory by DGH.

DGH reserves the right to make changes in the design and material of Equipment without incurring any obligations to incorporate such changes in Equipment already completed on the effective date of any such changes.

This is the only warranty of this product and is expressly in lieu of all other warranties, expressed or implied by law or otherwise, including any implied warranties of merchantability and of fitness for a particular purpose. Without regard to the alleged defect, DGH does not, under any circumstances, assume any responsibility for the loss of time, inconvenience or other consequential damages, including but not limited to, loss or damage of personal property, or loss of revenue. DGH has neither assumed nor authorized any other person (including any distributor authorized to sell its Equipment) to assume for it any other liability in the connection with the sale of Equipment.

25 Lifetime / Shelf-life

The shelf-life / lifetime indicated for this device is 5 years.
Customer Service

If you are having problems with this unit, please refer to the appropriate sections of this manual. Most service calls result from a misinterpretation of the operation of the instrument. The instructions in this manual have been carefully reviewed to ensure error-free performance of the DGH 8000.

However, if you feel there is a problem with the unit or a transducer, please contact the Customer Service Department at the address below. DGH Technology, Inc. can also be contacted via our website at www.dghkoi.com. When contacting us, please provide the model and serial number for the unit. The model number and serial number are located on the side of the USB probe and can also be viewed on the display by selecting the “About” button found on the “Help” toolbar.

Manufactured by:

DGH TECHNOLOGY, INC.
110 SUMMIT DRIVE
SUITE B
EXTON, PA 19341
USA (610) 594-9100

Authorized European Representative:

EMERGO EUROPE
Molenstraat 15
2513 BH, The Hague
The Netherlands
Phone: +31.70.345.8570
APPENDIX A  COMPUTER SYSTEM SPECIFICATIONS

Minimum System Requirements

- **Processor:** 32 bit or 64 bit, 2 GHz
- **Memory:** 2 GB RAM
- **Optical Drive:** DVD-ROM (For Software Installation)
- **Hard Drive:** 1 GB minimum, 100 GB recommended
- **Ports:** USB 2.0
- **Display:** 1024 x 768 Resolution
- **Peripherals:** Mouse (or Touchpad), Keyboard
- **AC Power Supply:** Medical Grade

Compatible Operating Systems

- Microsoft Windows XP SP3 or higher (32 Bit)
- Microsoft Windows Vista SP1 or higher (32 or 64 Bit)
- Microsoft Windows 7 (32 or 64 Bit)
- Microsoft Windows 8 (32 of 64 Bit)
- Microsoft SBS (2003 or 2008) - SQL Server Installation Only

**WARNING**

The use of a “Non-Medical” grade AC Adapter could potentially cause harm to the system, the probe, the operator and/or the patient.

**WARNING**

Using “Non-Essential” Software in Conjunction with the Scanmate System Could have Unknown / Adverse Impact on the Operation of the Device and is Therefore Not Recommended.

**WARNING**

Due to the Threat of Computer Viruses, it is Recommended that an Anti-Virus Program be Installed on the Computer Running the Scanmate Application and that Patient Records Be Backed up Regularly.
## APPENDIX B

### SUMMARY OF ACOUSTIC OUTPUT (12.0 MHz Probe)

<table>
<thead>
<tr>
<th>Index</th>
<th>MI</th>
<th>TIS</th>
<th>TIS</th>
<th>TIS</th>
<th>TIB</th>
<th>TIB</th>
<th>TIC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>-</td>
<td>Scanning</td>
<td>Non-scanning</td>
<td>Non-scanning</td>
<td>Scanning</td>
<td>Non-scanning</td>
<td>-</td>
</tr>
<tr>
<td>Acoustic working frequency (MHz)</td>
<td>10.4</td>
<td>10.4</td>
<td>NA</td>
<td>NA</td>
<td>10.4</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Output power (mW)</td>
<td>0.173</td>
<td>0.173</td>
<td>NA</td>
<td>NA</td>
<td>0.173</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Bounded output power (mW)</td>
<td>0.173</td>
<td>0.173</td>
<td>NA</td>
<td>NA</td>
<td>0.173</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Attenuated output power (mW)</td>
<td>0.056</td>
<td>0.056</td>
<td>NA</td>
<td>NA</td>
<td>0.056</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Spatial-peak temporal-average intensity (mW/cm²)</td>
<td>1.26</td>
<td>1.26</td>
<td>NA</td>
<td>NA</td>
<td>1.26</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Attenuated spatial-peak temporal-average intensity (mW/cm²)</td>
<td>0.41</td>
<td>0.41</td>
<td>NA</td>
<td>NA</td>
<td>0.41</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Peak-rarefractional acoustic pressure (MPa)</td>
<td>1.14</td>
<td>1.14</td>
<td>NA</td>
<td>NA</td>
<td>1.14</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Attenuated peak-rarefractional acoustic pressure (MPa)</td>
<td>0.65</td>
<td>0.65</td>
<td>NA</td>
<td>NA</td>
<td>0.65</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>-1 2 dB output beam area (cm²)</td>
<td>0.28</td>
<td>0.28</td>
<td>NA</td>
<td>NA</td>
<td>0.28</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Equivalent aperture diameter (cm)</td>
<td>0.60</td>
<td>0.60</td>
<td>NA</td>
<td>NA</td>
<td>0.60</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Depth for TIS (cm)</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td>NA</td>
<td>0</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Depth for TIB (cm)</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td>NA</td>
<td>0</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Depth at max. attenuated pulse-intensity integral (cm)</td>
<td>1.57</td>
<td>1.57</td>
<td>NA</td>
<td>NA</td>
<td>1.57</td>
<td>NA</td>
<td>NA</td>
</tr>
</tbody>
</table>

Supplementary information:

B-Mode only with 60 degree scan angle, 15 Hz scan rate and 256 lines per scan
**APPENDIX C**  
**SCANMATE-B SPECIFICATIONS**

<table>
<thead>
<tr>
<th>Imaging mode</th>
<th>- B Scan with Vector A-mode</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Functions</strong></td>
<td>- Standard USB Port (2.0) connectivity</td>
</tr>
<tr>
<td></td>
<td>- Multiple freeze method: button on probe, keyboard, or soft key on screen</td>
</tr>
<tr>
<td></td>
<td>- Zoom with enhanced resolution using 4 times over sampling</td>
</tr>
<tr>
<td></td>
<td>- Auto Image saves on Freeze</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>- Electronic, 0.015 mm; Clinical, &lt; 0.1 mm</td>
</tr>
<tr>
<td><strong>Gray shades</strong></td>
<td>- True 256 (8 bits) shades of gray</td>
</tr>
<tr>
<td><strong>Sector Size</strong></td>
<td>- 60 degree sector</td>
</tr>
<tr>
<td><strong>Transducer</strong></td>
<td>- High Bandwidth, single element: 12 MHz &amp; 15 MHz</td>
</tr>
<tr>
<td><strong>Depth selections</strong></td>
<td>- 3 cm, 6 cm (12 MHz); 5 cm, 10 cm (15 MHz)</td>
</tr>
<tr>
<td><strong>Measurements</strong></td>
<td>- 2 calibers for distance measurements</td>
</tr>
<tr>
<td><strong>Signal processing</strong></td>
<td>- Image Post-processing</td>
</tr>
<tr>
<td></td>
<td>- TGC control’s, near, mid and far</td>
</tr>
<tr>
<td></td>
<td>- Contrast and Image Intensity controls</td>
</tr>
<tr>
<td></td>
<td>- Frame averaging</td>
</tr>
<tr>
<td></td>
<td>- Interpolation</td>
</tr>
<tr>
<td><strong>Archive functions</strong></td>
<td>- Exam data: Patient name and comments</td>
</tr>
<tr>
<td></td>
<td>- Video buffer range up to 512 frames or 34 seconds</td>
</tr>
<tr>
<td></td>
<td>- Open system architecture</td>
</tr>
<tr>
<td><strong>Power Requirements</strong></td>
<td>- 5.0 VDC (+/- 5%)</td>
</tr>
<tr>
<td>obtained from the</td>
<td>- 500mA (maximum)</td>
</tr>
<tr>
<td><strong>USB2 port</strong></td>
<td>- 2.5 watts (maximum)</td>
</tr>
<tr>
<td><strong>Environmental</strong></td>
<td>- Max operating temperature 40°C (104°F)</td>
</tr>
<tr>
<td></td>
<td>- Min operating temperature 10 °C (50 °F)</td>
</tr>
<tr>
<td></td>
<td>- Operating humidity range 20 - 80% non-condensing</td>
</tr>
<tr>
<td><strong>Storage Temperature</strong></td>
<td>- 10°C to 50°C (14°F to 122°F)</td>
</tr>
</tbody>
</table>